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1. NEW FEATURES IN V21 

THE WELCOME SCREEN 

Version 21 has a very different look and feel.  To help you make the most of the new features, let’s 

start with the welcome page. Why not take advantage of the resources to learn a little more about the 

new features? 

The welcome page offers the opportunity, if you haven’t done so already, to set up defaults and 

settings for your company, but also provides links to other connected resource areas for example, the 

pension cost planner reports for auto enrolment: 

 

 

For clients with Sagecover or Sagecover Extra, there are also a wide range of extra reports and 

webinars which can be accessed from this page: 
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For the first time with this version, Sage has created a hybrid program combining the reliability and 

tradition of the desktop Sage program. We will cover setup of this feature later in the session, but note 

that the link to begin set up of Sage Drive can be accessed from this menu. 

Some clients have mentioned that they don’t want to see the Welcome page every time they open the 

program. Fix this by setting the opening page from this drop down menu: 

 

The program will remember your choice for the next time you use the program. 
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VIEWS AND SETTINGS 

The new layout of V21 makes it easier to find your way around, but also to customise the basic 

appearance of each screen on a day to day basis. Settings are specific to each user. 

The new screen layout is set to resize automatically for any screen size.  

Unlike the old modular system, the areas of the program are all available and clearly visible down the 

left hand side and for each area, all the relevant tasks are visible along the top of the screen, which 

makes finding the task you need, much easier. 

It’s possible that you may not need all tasks or areas of the program, so it is now easy to de-select 

those that are not commonly in use, to simplify the appearance of the program. To do this, right click 

in either the side panel (to turn off whole program areas) or the top panel (to turn off specific tasks in 

each area).  

 

After the right-click, the full list of available items appears. To stop any items which are not usually 

needed from appearing on the main display, uncheck the tick box next to the item in the list. In the 

example above, we have un-checked the tick against projects as these are not used.  

The resulting list now no longer displays ‘Projects’ but these can be re-instated at any time by right-

clicking and selecting again.  

For those just starting to use Sage, or with a very light use of the program, this easily simplifiable 

menu system can dramatically de-clutter the screen.  

This functionality is available at all levels of the program in Version 21, even the basic Instant 

Accounts. 
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SCREEN COLOURS 

As part of the simplification of the display, the main screen is displayed in monochrome, mirroring 

recent changes in Microsoft Office.  In order to aid contrast and differentiate between different areas 

of the program, it is possible to tweak the overall colour scheme and add custom colour stripes to 

each module if desired. 

To experiment with more contrasting displays, go to: Tools>Options. Click OK to proceed if asked.

   

 

Once the Options screen opens, select Colours and choose between Dark or Light contrast panels, or 

the default plain white screen. 
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If you have a wide screen, or have trouble following lines of information across the screen, you may 

like to experiment with choosing alternate colour lines as shown below.  

If this works for you, you may like to consider using a different colour for each area of the program, in 

order to differentiate them. To do this, whilst still in Options and Colours, click on the colour-dropper 

icon next to a module as shown below, then either choose a colour from the standard palette or  

 

choose your own shade and tint from the ‘define custom colours’ button, before clicking on OK. Click 

OK again on the main Options screen to confirm your choices, before checking to see whether the 

effect is helpful.  

Our example choice has coloured the customer module with alternate stripes of Wedgewood Blue. 

Amend the shade/colour if required, or return to options/ colours and click on the ‘Ignore custom 

colours’ box to return to the basic Sage colour scheme. 
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INACTIVE CUSTOMERS AND SUPPLIERS 

Over a period of time, there will inevitably be growing numbers of Customers and Suppliers, who have 

not transacted with the business for some time.  Whilst there is history on the account, these cannot 

be deleted and indeed the business may not wish to permanently remove the contact details in case 

these are needed in future. 

Nevertheless, it can be quite surprising how many of the Customers or Suppliers who we scroll 

through every day, are no longer active. 

To speed up daily processing with those who still conduct regular business, it is now possible to tag a 

Customer or Supplier as inactive in their record. This does not remove either the record or the activity, 

but the Sage user can choose not to display these accounts, in order to make finding ‘live’ accounts 

much quicker. 

To mark an individual Customer or Supplier as inactive, go to the individual record and click the 

check-box to tag the account as inactive. Save to confirm the change. 
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On closing the record, view the list of suppliers. The inactive supplier still appears in the list, as 

‘Include Inactive’ is ticked at the top. 

 

 

To show only active suppliers, clear this tick-box and note that the supplier marked as inactive is no 

longer included in the list. 

 

Please note that it is not possible to tag a record as ‘inactive; whilst there is an outstanding balance 

on the account. 

BATCH CHANGES 

If your business has a very large list of customer and suppliers and you have Sage 50, you may wish 

to use the powerful ‘Batch Changes’ function to make the change to all inactive records at the same 

time. Great care should be exercised when using this function, as any errors will be imposed on all 

selected records. A full backup beforehand is therefore strongly advised. 
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After taking a backup, we first need to determine the period of inactivity which needs to pass before 

tagging a client as inactive e.g. no orders since the last year-end date. 

Having decided on the criteria for tagging, the next step is to identify all the customers or suppliers in 

the list which meet the criteria. On a list of several thousand, this could be an arduous task, but 

fortunately we have the powerful search function to help.  

First click on Filter. The filter box appears. From the drop-down menu in the first section choose 

‘Where’ 

 

Then use Tab to move across the sections, using each drop-down menu to complete as above, and 

entering the defining cut-off date which you have chosen in the final ‘Value’ box. Select ‘Apply’, then 

‘Close’.  

The resulting list should now only show those who have not placed an order since the date selected. 

The filter at the top of the main window indicates how many have been selected. 
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Now highlight all the records in the filtered list.  

Do this by highlighting one record, clicking swap, then clicking on the same record again to complete 

the selection. This technique can be used all over the program to speed up multiple selections. 

 

With all the records in the list highlighted, click on ‘Batch Changes’. A blank record template opens. 

 

Any changes now made to this batch changes template will be applied to (and will overwrite) the 

selected field in each of the highlighted records. In this instance, we want to treat all selected records 

as inactive, so on the template record, tick the ‘inactive’ box. If you are happy with your changes, click 

on Save. A further safeguard window will ask you to confirm the save. 

 

The selected field will now be updated in all the highlighted records. 
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This powerful process can come in handy for other tasks which may affect large numbers of records. 

The recent change in legislation regarding settlement discounts required large scale changes to data. 

For detailed instructions on how to use Batch Changes to correct settlement discount settings, please 

visit my post on LinkedIn or look up the news article on our website. 

Returning to the list of records, restore the full customer list by removing the filter again 

 

Once the full list shows again, experiment with clicking to ‘include inactive’, then removing the marker 

to see the difference. 

 

WINDOWS SELECTION TOOLS 

In previous versions, you were limited to selecting one record at a time.  

In version 21, Windows Standard selection tools allow you to use the Ctrl and Shift keys to select 

multiple records. This can also be enabled on upgraded data via Tools > Options > Environment 

 

Keyboard shortcuts 

 

  Holding Ctrl will allow you to select non-concurrent records 

 

 

                                   

Select a record, hold shift then select a later record to select all the records in between. 

 

You can now type the reference you are looking for on a list too – previously searching for ‘Sage’ 

would jump to ‘S’ then to ‘A’, but now will find ‘SA’. 
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ERROR CORRECTION FROM THE AUDIT TRAIL 

 

The Audit Trail is now displayed under Transactions (the old Financials Module no longer exists). It is 

no longer necessary to go to a separate corrections module, as this functionality has been 

incorporated into the transactions list (the Financial Reports have also been relocated, and are now 

found as icons in the Nominal Codes area). 

 

Corrections can be carried out directly from this list, which carries all the original Find and Search 

functionality, to help you to track down the entry you need. 

 

BACKUP MANAGER 

 

Using the new Data Service, it is now possible to set a time and frequency for backups to be taken 

automatically. This will also work on multiple datasets at once if applicable. 

 

In previous versions, it has always been necessary for other users to log out of Sage while backups 

are taken, but with the latest version, this is no longer necessary. Backups can be taken or scheduled 

to take place while users are logged into the data. 

 

You can view check data results from all the datasets on one screen (only reports on data checks 

done by the Backup Manager). 

 

To set up a scheduled backup, login as MANAGER, go to File> schedule backup 
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The Backup Manager screen opens, and will display the status of all connected datasets on the same 

screen. To set the frequency, timing and location of backups, click on settings 

 

 

Then choose either a single time once a day, or if you choose to back up more than once per day, 

select the frequency and the time to start. The backups will automatically be stored on the C: Drive of 

the computer. 

If you wish to specify a different location, select it here from the drop down menu. 

Please note: In order for the backup to be successful, this drive location must be accessible and 

powered up on the times and days when backup has been 

set to occur. 

If the drive is on a machine which is not turned on, or relates 

to a plug-in drive which is not currently connected, a backup 

will not be taken. 

It is advisable to check the named drive initially, to ensure 

that the backups are being successfully taken and recorded 

as set. 

The default setting is to back up data only, however further 

(or all files) may be included if required, by ticking the extra 

boxes as needed. When all selections have been made, click on Save.   

One of the best aspects about this new feature is that it removes the need to allow time at the end of 

the working day to backup, allowing extra time to complete constructive tasks instead. 

For details of Sage Drive, please go to Section 4 a. 
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2. PERSONALISING DOCUMENTS 

ADDING A LOGO OR IMAGE 

Since Version 19, it has been much easier to add scanned images and logos to documents. These 

can not only help to improve presentation, but clearly identify your paperwork with your business 

image and draw the eye – very useful in a pile of invoices waiting to be paid!. 

Images and logos can be added to any document produced in Sage, whether invoices or statements 

or perhaps chasing letters. 

In the example below, I have used an A4 invoice layout, but the same principal will apply to whichever 

document you choose. 

Go to the invoicing module and highlight an invoice from the list. Click print and select the layout 

which you wish to amend. 

 

With the layout highlighted, click on edit to open the report layout. 

When the report layout opens, you should see a screen similar to the one below. Although it looks 

complex, making the kind of changes which we need is quite simple. 

All the tools to add logos or images, lines or text are shown in the context bar, and extra help is also 

featured in the dynamic help section on the left. 
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Click on Add Image in the Context bar, then click and drag to draw a box on the document, marking 

the position where you would like the logo or image to sit. Don’t worry too much about size, as this 

can always be adjusted once the image is embedded.  

 

Once the text box has been drawn, the following window will appear. Select OK, and browse to where 

your image is stored. 

 

When you have selected the image, click open, and the picture will embed itself onto the document. 

Now is time to click and fine tune the size, aspect and location dragging the image into position if 

required using the automatic alignment lines which appear automatically as the box moves, to help. 
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The size and aspect of the image can be changed by clicking and holding one of the corners of the 

image and dragging the corner or side until the image is how you want it. 

For further options on positioning images, consider using the dynamic help box, which offers set 

positioning and alignment for any images added. 

 

 

ADDING BANK DETAILS FOR BACS PAYMENTS 

To add bank details to an invoice, follow the same procedure as above, but this time choose to ‘add 

text’ from the context bar. Draw the box for text in the position where you would like this to appear. An 

example of the potential bank payment detail box is shown below:  

The style and size of text can 

be selected from the drop-

down boxes at the top of the 

page. 
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Bold, Italic and Underline functions are also available if needed. 

To check the finished appearance of the updated document, go to View and Preview. This will show 

how the document will look once printed. 

 

The document can also be amended in the preview window if you wish e.g. boxes moved or text 

bolded. Any changes made here are carried back into the main document. 

When you have finished each document, click on File and Save As, saving the document with an 

updated name, which identifies its properties e.g. A4 Inv/Crd with Logo. Click Save. 
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Now go to File and Exit, closing the Report Designer file. When next printing an invoice, the new 

layout with logo will appear in the layout listing, and can be marked as a favourite. Note that the new 

file name appears on the right hand side of the layout description. 
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FORMATTING FOR IMPACT 

With all these tips, we aim to find areas of the program which you may not have used previously, but 

which contain some helpful tricks to help your stationery get noticed and ultimately, to be paid 

promptly for the goods or services which your business provides. 

Drawing a customer’s attention to late or large amounts awaiting payment is an essential part of 

debtor control. 

It is possible to instruct Sage to print any items which fit specific criteria in another colour, or in Bold 

Type. This can be preset and is particularly effective when used with emailed documents, since they 

are often viewed on screen before being printed. 

If you would like to give this a try, we would suggest that you begin with the ‘A4 Grouped and O/S A4 

email statement’, as this would be an effective demonstration of the impact which this conditional 

formatting brings. 

If you don’t wish to try the effect at present, please go straight to the beginning of the next section: 

‘Finishing Touches to Email Formats’: 

 

COLOUR AND TYPE FORMATTING 

To begin, go to the Customers module, highlight a customer with a balance, and click on ‘Statement’ 

and select the layout mentioned above. Click ‘Edit’ to open Report Designer. 

For this example, we have chosen to make any amounts in the Older Box, appear in Bold Red Type 

with underlining, in order to draw attention to these. 

At the bottom of the Statement, look for the ‘Older’ Box where the Aged totals are displayed. 

Click on one of the variables in the box, hold down CTRL and then click on the other as shown  

 

so that both are highlighted. 

 



 
 

 

 Sage Plc and Albert Goodman LLP Page 21 of 47 Produced by Alison Parsons 

In the Appearance section of the Properties box on the right, click on the plus sign beside ‘Text Style’ 

 

Tip: If the Properties box is not showing on the right, you can make it appear by going to View at the 

top of the screen and clicking on Properties. All the extra Toolbars and Help Boxes can be turned on 

and off this way. 

From the menu which opens, click beside each option and select your choice from the drop-down 

menu until you have the look that you feel would be most effective. 

In the example below, we have chosen to print the information in the ‘Older’ box in Bold Red type, 

with a heavy underlining. 
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The text within the document changes as the selections are made. 

When all selections are complete, go to View and View Preview, to look at the effect on the finished 

Statement.  

Tip: If you would like to take this effect a little further, it 

is possible to set conditions for when a Report will print 

a certain item of information in a selected style. 

For example, if a balance is more than a certain 

amount, print it in Bold or Red (or any other colour of 

your choice) 

If you would like help with this, please either contact 

Sage Cover, or ask your usual AG contact for further 

information. 

 

 

 

 

FINISHING TOUCHES TO EMAIL LAYOUTS 

Before completing the defaults in the following section, there are extra presentational tips which can 

help to provide a professional finish to documents which are to be sent by email. This is especially 

important if your business normally uses pre-printed stationery, as there would otherwise be few 

identifying details on the blank layout. 

Although these extra touches take a little time to set up initially, the process only needs to be 

undertaken once. We consider that for many businesses this is well worth the effort, as we estimate 

that each document sent by conventional means can cost the business in the region of £1 per item.  

As with the conversion to E-Payslips discussed at our last session, this can produce a considerable 

saving for the business. 

Example: Configuring an invoice layout for emailing. Go to the invoicing module, highlight any invoice 

and click print. Select the layout which you wish to use for emailing (note that it must state Email in 

the description).  
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Click edit to open the Report Design screen. 

On the right hand side in the ‘Properties’ box, scroll down until you see the Bold Header ‘Email 

Options’. Click on the words ’Email options’ in normal type in the line below. 

 

Now click on the button with three dots which appears on its right. 

The email Settings box which now opens, allows you to enter a personal message which will appear 

in the body of every email, to which this layout is attached. 

This is a good opportunity to add contact details, and ensures that queries are more likely to be 

resolved early on, increasing the chances of prompt and full payment. 
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Simply click into the text box below, and add your own personal message.  

Please note that this message will remain constant and will not change with different invoice numbers 

or customers. 

If you wish to ensure that your customers have looked at the invoice, a read receipt can be requested, 

however please bear in mind that if you are sending large numbers of emailed invoices, this could 

potentially be more hindrance than help. 

Click OK, and then save the updated document. 

Once this is complete for each of the documents which you wish to use for email, proceed to the final 

stage, setting the defaults and instructing the program of each layout name to use. 
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SETTING EMAIL DEFAULTS 

Before commencing this task, ensure that you have made a note of the layout name of all documents 

which you wish to use for emailing, and have already made any necessary amendments to the 

layouts using the previous section.  

To select specific layouts for use in emails, go to Settings and select Email defaults 

 

Email Client Tab: 

The first tab of email defaults deals with setting up the mail client. This is automatic for those who use 

Outlook. If you use another mail provider and need help setting up your mail client, please either 

phone Sagecover or contact your usual AG contact who will put you in touch with a member of our 

Sage team. 

Stationery Tabs: 

These tabs define the appearance of emails containing Invoices, Sales orders, Purchase orders and 

Remittance Advices respectively. 
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Start with the Invoice tab and work through the other documents which you may send my email. 

The email fields confirm the source of the email address, together with the subject line. The aim is to 

get the important information across in this line, so that your customer or supplier gets the information 

they need to deal with the email quickly. Click on ‘Subject’ to show the choice of formats which will be 

applied to each document. 

 

The ‘Manually entered’ subject, allows you to enter your own personal greeting if you prefer. 

Simply click into the line and the Subject line will be untilised whenever an invoice is sent. Please note 

that this greeting will not adapt to include Invoice Numbers etc as the other subject headers do. 
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Next, choose whether the document is sent as a PDF attachment, or as part of the emal itself. If you 

prefer not to use attachments, tick this box. 

 

The next Attachment section deals with the appearance and labelling of the emailed document. For 

example, Report Designer can package an Invoice which is being sent as an attachment, in Excel, 

Word or PDF format. Depending on the circumstances, you may prefer to send by PDF so that the 

document cannot be altered once it has left your mailbox. 

The Attachment Filename section, determines what the attached invoice will be called, therefore how 

it will look when your customer is looking for the document on his own system. 

 It pays therefore to make it as easy as possible for the recipient to be able to differentiate the correct 

item not just from other similar emails from you in his Inbox, but from others subsequently stored on 

his computer.  

Click on the drop down menu in each section to view the options. The more distinguishing 

information, the more likely it will be that the invoice can be found when it’s time to pay! 

PDF Password ensures that only the recipient who holds the password will be able to open any PDF 

attachments to view them. This is especially useful in the case of sensitive documents. If Yes is 

selected, the password will be taken from the ‘Reporting Password’ field on the defaults tab of the 

customer record. 

Note that once this is entered, it is displayed as a series of stars; therefore if the customer forgets the 

password, another will need to be set and typed in in its place, before re-sending the document. 
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In Outlook Settings drop-down menu, any stored electronic signatures can be applied if you wish, to 

improve the appearance of the body of the email. 

Finally, Sending Options chooses between sending the documents directly on instruction or 

depositing them in the mailbox for checking and manual despatch. At least for the first few runs, we 

would recommend this latter method. 

Once all the tabs required have been completed, click on Apply. This step should only be taken once 

all the settings on each tab have been chosen. 

The apply command, brings up a list of all the layouts to 

which the chosen email formats will be applied. Take 

care with the selection to ensure that only the correct 

layouts are selected. 

Use the + button to expand out each relevant section in 

turn, ticking the relevant layouts of each type of 

document until all those you need have been selected. 

Finally, click on OK. This will now update the program 

settings, adding the instruction to use the applied, 

updated layouts each time an emailed document is 

sent. 

 

Back at the original email defaults screen, click on OK to complete the task. 

 

TIP: We would suggest a trial run or two before putting these generally into use. A good way of testing 

out the system is to pick one customer, note the current email address and then temporarily overwrite 

it with that of your own company email.  

When a test invoice is emailed to this customer, it will then be emailed to your own address, for 

thorough checking, 
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THE PAY NOW BUTTON 

If your business accepts card payments from Customers and uses Sagepay to process these, it is 

possible to embed a ‘Pay Now’ button on emailed invoices. 

Simply select an email invoice or statement with the words ‘with Sagepay’ in 

the description, ‘Pay Now’ Button will automatically appear on the invoice, 

below the total amount when it is opened. 

The Customer can click on this button, which then takes them directly to Sage pay’s secure payment 

portal.  

If you would like more information on how Sagepay works please follow the link below: 

http://www.sagepay.co.uk/our-products/einvoice-payments 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://www.sagepay.co.uk/our-products/einvoice-payments
http://www.google.co.uk/imgres?imgurl=http://www.theafterschoolclub.org/gfx/pay-now.gif&imgrefurl=http://www.theafterschoolclub.org/payment.html&h=64&w=151&tbnid=dPXtsba2IN8OLM:&zoom=1&docid=lhN7dPMMUzhMUM&ei=mINwVY-sIJKf7garmIHgCg&tbm=isch&ved=0CCoQMygKMAo
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3. INTERNET BANKING 

E-BANKING – BEFORE YOU START 

 

This section helps to provide a checklist and sequence of events to help you set up E-Banking. This is 

a useful time-saving service which enables you to perform the following: 

 

 Pay your suppliers from your desktop and upload to your bank. 

 

 Download a Bank Statement directly from your bank to perform an electronic bank 

reconciliation. 

 

The bank account through which you wish to conduct E-Banking must be connected to an Internet 

Banking service, such as Barclays Business Master or RBS Royaline. 

 

Note: Before you can start using the E-Banking function, you must first contact your bank.  They will 

provide you with their software, which enables you to use the Sage E-Banking function.  Most major 

banks have software that is compatible with your Sage accounting product. 

 

SUPPLIER BANK INFORMATION 

 

Many suppliers now provide their bank account information routinely on documents such as 

statements and invoices.  

 

If you need to gather banking information from large numbers of suppliers, this can be done by 

creating a mail merge letter to suppliers directly from Sage. If you would like assistance with this 

process, please ask your usual AG contact, who will put you in touch with a member of our Sage 

team. 

 

Tip: When paying by BACS, it’s good practice to send a remittance advice to the supplier, to let them 

know that you have settled your account. This can also be done by email, saving postage. In order 

that the correct person receives this notification, consider designating one of the email fields 

specifically for accounts information.  Please see the later section in the notes regarding remittances. 
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SETTING UP E-BANKING 

 

From the Settings menu, select Bank Defaults and ensure that there is a tick beside the E-Banking 

option: 

 

 

 

The activation will add an extra Bank Type section to each bank account record.   

In the Bank module, select and open the bank record which you want to enable. From the Bank 

details tab, click on the drop down menu in the Electronic Banking section to select the correct bank’s 

software. 

 

 

 

NOTE: The correct selection is absolutely crucial, since the banks format payment information fields 

in a different order. One bank’s account number field may represent the amount for another bank! 

In the Account details section, complete the Account Name, Account Number and Sort Code fields. 

The sort code and account number must match those on the file to be imported from your bank. 

 

Select the Configure button and check the settings. 
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This screen allows you to specify where the import files (bank statement transactions) and export files 

(supplier payment transactions) are to be stored on your PC.   

 

The different types of Bank packages will have their own specific configuration requirements, and 

many will auto-populate the storage location for you. If you are unsure, please check with your bank 

before proceeding. 
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E-BANK RECONCILIATION 

 

E-Reconciliation is available as an option on Sage in conjunction with most banking software. Once 

E-Banking has been configured and fully set up, go to the Bank Module.  

 

Select the bank account which you wish to E-Reconcile, then click on the Reconcile icon at the top of 

the page. From the drop-down menu which appears, select E-Reconcile as shown below.  

 

NOTE: If your screen is very wide, E-Reconcile may appear on its own in the top bar, ready for 

selection. 

 
 

 

 

At the prompt, enter your statement end date and end balance as usual, then click OK to proceed. 

 

The E-Reconcile screen now opens. Check that the data and end balance which you entered are 

correct, and then go to File and Import Bank transactions, to pull in a list of transactions from your 

banking software. 
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The software downloads a batch of transactions, based on the date selections you have requested.  

 

Note: The software marks each batch of transactions once it is downloaded for reconciliation, to 

ensure that it can only be downloaded once in order to avoid duplication. 

 

Before beginning E-Reconciliation, choose which way you would like the matching process to work. 

Within the E-Reconciliation screen, go to Tools, Options. 

 

 

 

The default position is that the transactions from your imported bank statement are matched to those 

which you entered into Sage. If you wish to match Sage to the list of Bank transactions, select the 

other radio button here, and click OK. 
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THE MATCHING PROCESS 

 

Once the bank statement transactions are loaded into the top window, choose whether to let the 

software match and reconcile transactions automatically, or to match manually. 

 

 

 

 

There are several options for automatic matching: 

 

Match Full – Both the Amount and the Reference of an item must match before an item will be 

selected. 

 

Match Amounts – The first amount in the list which matches, will be selected 

 

Match Ref – The first item with the correct reference will be selected. 

 

Any items which are not automatically matched, can be matched using the manual matching process. 

 

From time to time, there may items where you disagree with the automatic match, for example, where 

the option chosen is Match Amounts, there are are several receipts for £50 and the one selected is 

not the particular receipt you wish to match in this instance. 

 

At the top of the window, is a Tasks menu, which provides a list of the optional tasks to help deal with 

this. 
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Clear Selections – This de-selects highlighted items in either the Bank or the Sage Window. 

All other Tasks in the list – These carry out the selected instruction on either highlighted items only, or 

all items in each case. 

 

In this way, matched items can be unmatched, unconfirmed items confirmed, and so on. 

 

If you have large numbers of transactions in each reconciliation, you may like to switch to showing 

only Unconfirmed transactions, so that the only items showing are those not already matched. Before 

reconciling, we would recommend that you switch back to showing all transactions, in order to 

perform a final check that everything is correctly matched before proceeding.  

 

To toggle to showing Unconfirmed items only, go to View and select Unconfirmed. 

 

 

 

As with the standard bank reconciliation, the automatic total boxes at the base of the screen update 

with each change, showing your progress towards completion. A copy of the reconciliation can be 

taken at any point by clicking File> Print. 

 

Finally, when you are happy with all selections, click on Confirm, check that all the transactions 

selected are confirmed, then click on reconcile when ready, to flag confirmed transactions as 

reconciled. 
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PAYING SUPPLIERS BY BACS 

 

Ensure that: 

 

The E Banking and Bank Account set up procedure, described above, has been carried out. 

 

The supplier record has been set with the supplier’s bank account details, and Online Payments has 

been activated. From version 2009 onwards, when choosing the Payment Method as BACS, Direct 

Debit or Standing Order, Sage automatically ticks the online Payment field for you as shown below. 

:  

 

 

Occasionally, you may need the option to pay a supplier by more than one method. The latest version 

of Sage can be set to offer up to five different payment methods for each supplier. To access this 

option, click on the button with three dots ‘…’ beside the Payment method Drop down menu. 

 

The User-Defined Payment Methods window opens; allowing the selection of up to five different 

personalised payment descriptions which can also be selected as available for online payments is 

desired. To Mark as available for Online Payment, Click in the online check-box beside the method. 
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Once complete, click OK to save your choices. The additional personalised payment methods will 

now appear in the Payment Method 

MAKING A BACS PAYMENT 

 

Once the above settings have been put in place, proceed as if generating a normal supplier payment, 

leaving the Cheque No. field blank.  This field will default to (BACS), wherever Online Payments has 

been activated in the supplier account record: 

 

 

 

When you Save the payment, it is transferred to the E Payments module, where it is processed using 

a similar routine to that for printing cheques. Continue to make any other supplier BACS payments 

until all have been posted. 

 

To despatch the payments to your bank software, go to the Bank module, click on the Payments drop 

down menu. Select E-Payments. If your screen is wide enough, you may be able to see E-Payments 

in the main top menu. 

 

Highlight the payment(s) which you want to send at this point and click on Send. 

 

 
 

The following confirmation screen will appear. 
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Click on the Show Details button if you want to view the destination bank details, which are obtained 

from the supplier account record. The Show Details screen also offers the opportunity to print the 

payment confirmation if required. 

 

Once the details of the payment have been checked, Select OK, and Save the file. 

 

The details are now sent to a Payments File that is Imported (or similar) into your Bank software, 

which carries out the actual payment.  Once sent, the payment cannot be ‘re-sent’ and should no 

longer appear in the Send Payments list. This is a protective measure designed to avoid accidental 

duplication of payments. 

 

If the payment still appears in the list, this means that the payment has not been successfully sent. If 

there are any problems with transferring your E-Payments, you are prompted to view an error log.  

The error log lists reasons why your E-Payments transfer has not been successful. 

 

It is possible to print a Remittance Advice to despatch to the supplier, after sending the E Payment. 

To do this, click on Remittances (either part of the Payments drop-down in the bank module, or an 

icon of its own). This will show a list of remittances to print. Alternatively, the system can be set to 

email each Remittance to a given contact at the supplier.  

 

Note: You cannot generate E Payments using the Batch Payment routine. 
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4. SAGE DRIVE AND TRACKER APPS 

Version 21 marked the start of a new generation of Sage Accounting software, being the first Hybrid 

release, providing the reliability and proven track record of desktop programs, combined with the 

accessibility and convenience of cloud accounting. 

 

Note: For those clients who rent the program on a subscription basis, or who have Sagecover Extra, 

the basic service is provided free of charge on an ongoing basis. For clients converting to version 21 

for the first time and buying the program outright, Sage Drive is free for the first year. If you choose to 

continue on the same basis after the first year, a monthly fee is payable for the use of the service, 

which can be cancelled at any time.  

 

If you feel that this service would be useful for your business, please ask your usual contact at AG, 

who will put you in touch with a member of our Sage team. They will be able to provide more 

information on the options for connection, aiming for the most cost effective way to access the 

service, based on your individual business requirements. 

 

CAN I TURN OFF THIS FUNCTION? 

 

This is an additional, optional feature of the program, which is not necessary for its normal traditional 

function. Therefore if you do not want to use the cloud for your business, simply continue to use the 

program as you have done previously.  

 

The cloud-based Sage Drive link only functions if specifically set up and turned on, and this can only 

be done by the data owner – yourself, keeping you in complete control at all times.  

 

SECURITY 

 

Many Businesses are naturally concerned over security of data storage in the Cloud.  

 

All Sage Cloud servers are based in the UK or nearby European Countries and are therefore 

governed by the strict data protection legislation from both the UK and EC. Data is encrypted to the 

same level as internet banking information to provide a high level of security. 

 

If you require further information regarding security of information, please contact Sage for advice. 
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HOW THE NEW HYBRID SYSTEM WORKS 

 

Sage Drive is a cloud based data sharing system, which uses the power of the cloud to synchronise 

Sage 50 Accounts data across multiple PCs. All Sage V21 licences come with access for one Sage 

Connected User and one Sage Connected Accountant. Additional connectivity can be added if 

required. 

 

The data owner makes the decision to ‘push’ a copy of the data up to the Cloud Server. This creates 

a copy of the data from the local PC in the Cloud and synchronises the data via the Data Service and 

the internet to keep all PCs up to date, wherever they are.  

 

This connectivity relies on each PC being connected to the internet, in order that updates can flow to 

all participants, as they are created.  

 
The new Sage Drive is ideal for businesses which want to retain the conventional functionality of the 

program, but may benefit from being able to access the program from other locations, or may employ 

field or outworkers. 

 

The new system allows the MANAGER logon to control specific access to the data once it is pushed 

to the cloud, including access for a named accountant free of charge.  
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SETTING UP SAGE DRIVE 

 

Before starting the process, please make sure that you have to hand a note of the program Serial 

Number and also your Account number with Sage, as these will be needed later in the process. Both 

these should be shown on any invoice or cover certificate from Sage. Once you have this information, 

please proceed as follows: 

 

Login to Sage Accounts as Manager, then go to File> Set up Sage Drive. 

 

 

 

You are then asked to register for the service, as part of the initial security procedure: 

 

 

At this point you will be asked to set up a 

Sage ID, if your company does not already 

have one.  

 

Note: The email address which you provide 

for Sage Drive, must be the one which the 

person who owns the MANAGER login has 

access to. For security, this should not be 

accessible to other personnel. 

 

Click the ‘I don’t have a Sage ID’ button and this will direct you to a secure web form, where you can 

register the email which is to receive Sage Drive requests for authorisation, together with a Sage 

Drive specific password. This should not be the same password which is used to access sage on a 
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regular basis and should be sufficiently complex to provide extra security against unauthorised 

access. Click on the ‘Create’ button to close. 

 

On completing the Sage ID setup, you will be sent an activation email, to the e-mail address 

registered when the Sage ID was created. Follow the link in the email, to the Sage Drive Welcome 

Page, as shown below. 

 

 

 

When you click Register, the service will ask you to re-enter the new Sage Drive ID and Password, to 

confirm your identity, before clicking on the ‘Sign IN' button. 

 

When prompted, enter your Sage Account number and Serial Number. Once these are entered, the 

‘Register’ button becomes active. Proceed to Register. 

 

The service now establishes a link to your Sage account, and ultimately, to your data. If your license 

includes more than one company, or more than one user, extra free entitlement to Sage Drive access, 

and also to the free Tracker and Mobile Sales Apps to match your license, will be added at this stage. 

 

Once you receive the message that 

Registration was successful, return to the 

program and login again, proceeding as 

before but this time, click on ‘Sign in’ and 

enter your Sage Drive details. 
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Once these have been accepted, the service will ask you to set the final level of security. This 

encryption password will be the key which is given to those granted remote access, to allow their copy 

of Sage to ‘decode’ your encrypted data.  Please create a fresh password for this purpose, using a 

combination of character types as determined by the program, so that it cannot easily be guessed. 

 

 

 

 

NOTE: This Password is NOT recoverable; therefore it is very important that you remember it. 

 

Having set the password and a hint to help you remember it if required, please read the Terms and 

Conditions carefully and then tick the box to agree to these if you choose to proceed. 

 

Once you have indicated your agreement, the Upload Data Button will activate. Click the button to 

‘Push’ a copy of your data onto the Cloud Server. Once the Confirmation message is received, the 

next step is to grant access to individual users who have your permission to connect remotely. 

 

 

 

If you click Close by accident at this stage, don’t worry. You can access the Management Centre at 

any time when logging in as MANAGER, by going to File>Manage Sage Drive. Click on ‘Management 

Centre’ to begin to assign access to the service. 
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CONTROLLING ACCESS TO SAGE DRIVE 

 

In the Management centre, click on your company name, to expand a list of users. The Manager 

logon (who originally set up the service) will automatically be connected. 

 

If your license encompasses more than one company, these will be listed separately, so that you can 

grant access to one, or both on an individual basis. 

 

 

 

To grant remote access to either remote PC users  or those who would like to use the Tracker or 

Mobile Sales Apps, click on the ‘Add Users’ button. 

 

Enter the name, then the email address used by the person to whom you are granting access, before 

clicking in the relevant column to grant access as either a user, or your accountant. In the case of 

user, this is also where you can click to grant access to the Mobile Sales and Tracker Apps. 

 

This entitlement can be withdrawn at any time, or the user removed by clicking the remove user 

button.  

 

The named user will now receive an activation email, allowing them to begin the setup process on 

their remote PC, mobile or tablet. 
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FREE SAGE TRACKER AND MOBILE SALES APPS 

 

Sage Tracker and Mobile Sales Apps are available as standard for Sage Drive users of Sage 50 V21, 

and also now for the new Sage Instant V21. 

 

They provide a great way for business owners and managers to access key financial information 

securely in real-time, on the move and away from the office. 

 

Once set up, the information can be accessed even if the user has no Wi-Fi or mobile signal. Once 

internet connection is restored, the data is refreshed again in real-time with the live Sage data in the 

office, keeping your information up to date. 

 

The interface is intuitive and easy to use, and contains extra information to help your business, for 

example, maps to pinpoint a contact’s location when visiting a customer or supplier. 

 

The App can also show a Dashboard view, giving a summary of key information, which can then be 

drilled to access further detail. The App is available to download in two versions, for Mobiles (shown 

below) and for Tablets (shown on the following page) where the software can take advantage of the 

larger display area, more suited to viewing whole documents such as invoices.  

 

 

The App can also display detailed Customer and Supplier activity lists if required and report on 

amounts owed to and by the business, should you need it. Current bank information and balances 

can also be viewed in real-time, allowing spending decisions to be made with confidence. 

 

Sage 50 Accounts Tracker for owner/managers (mobile only)

47

New Sage 50 Accounts
4.4 New apps
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The Tablet version (shown below) allows sales staff to raise orders and invoices on the go, which are 

then synchronised with the main data in the office. 

 

Contact details for customers contain both map and direction information, and connection can be 

made direct from the app by phone, text or email, making it an ideal tool for staff or managers whilst 

travelling. 

 

 

 

 

 

To find our more details about how the Tracker App works with V21 Sage 50 and V21 Instant 

Accounts, please follow the links below: 

 

For Sage Instant Accounts:  

https://www.youtube.com/watch?v=fTvWwj_Lu-8&feature=player_embedded 

 

For Sage 50 Accounts: 

https://www.youtube.com/watch?feature=player_embedded&v=CxpetPXcDHo 

 

We are always keen to improve our service wherever possible, to make it relevant and useful to our 

businesses clients. We would be very pleased to receive any feedback which you would like to offer 

regarding both the Workshops and these notes. Please contact Alison.parsons@albertgoodman.co.uk 

or speak to your usual AG contact.  

 

Alison regularly posts useful Sage updates and information on her LinkedIn page. Please feel free to 

connect with Alison on LinkedIn, to keep in touch with these articles. 

 

Albert Goodman LLP June.2015 

Sage 50 Accounts Mobile Sales for Sales People – (Tablet only)

https://www.youtube.com/watch?v=fTvWwj_Lu-8&feature=player_embedded
https://www.youtube.com/watch?feature=player_embedded&v=CxpetPXcDHo
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